Overtime Management Software Manual

Creating an Account

Enter the web address for live software is 192.168.3.20/ot in a browser( Firefox, chrome or
internet explorer etc.) Note: Test Application: 192.168.3.103/test-ot

Self Service
ECG Application

Welcome

Please sign in to your account below.

Enter Username

Enter Password

Don't have an account? Create an Account | Recover Password

Login to Dashboard

elf Service Application 2020

Click on “create an account”
Enter your username, password and Staff ID (NOTE: Username must be ECG active directory
username)

Self Service
ECG Application

Create a new Account
Account SetUp
Enter a Username
Enter a Password

Enter your Staff ID

Create Account

Copyright © ECG Self Service Application 2020

Click on ‘Create Account’ to create your new account
You will be redirected to the login page



Login Page
e Enter the web address (192.168.3.20/0t) in a web browser (Firefox, chrome, internet explorer

etc.)

Self Service
ECG Application

Welcome

Please sign in to your account below.

Enter Username

Enter Password

Don't have an account? Create an Account | Recover Password

Login to Dashboard

Copyright @ ECG Self Service Application 2020

e Enter your username and password you created.
e C(Click on “login to dashboard” to login to the software



Dashboards

Depending on whether you are a direct report, hr officer, district manager or supervisor your dashboard
menu will match your role in the software. Lets go through all the different roles and their dashboards:

Direct Report Dashboard

ANTHONY MENDS JNR

.
Self S =
ECGI Kppiication = [

MENU

User Dashboard
Dashboards

My Dashboard

Notifications

e At the top right corner of the page, you will see your name, designation and district

~

e Beside your name, designation and district, is an icon , click on it to display your name,
region and district and a logout button.

e Click on the logout button to log you out of the software when you are done, to prevent
unauthorized people from gaining access to your account.

e To the left side is your menu, you would see, My dashboard and My Overtime

My Dashboard

My Dashboard Page is where you will see all the overtime created for you by your supervisor on the
Notifications sections. Displaying the name of the Overtime, the date of its creation and the status of it.
Note: it only shows up to 20 of the last created overtime.

My Overtime Page

My Overtime page shows all your uncompleted and completed overtime. Uncompleted Overtime also
known as Planned Overtime are overtimes that have been created by your supervisor, but you have not
responded to it yet or you have not completed the job assigned to you. Completed Overtime are
overtime that has been completed in the system as well as on the field.



How to Complete an Overtime

e C(Click on the reply button the overtime that you have completed the work on the field. At the
uncompleted overtime section, you will be transferred to overtime complete page.

UNCOMPLETED OVERTIME

Status Overtime Description Date Created

PLANNED this is an overtime Sun 06 Dec 2020
PLANNED this is an overtime Sun 06 Dec 2020
PLANNED this is truly an overtime at home Sat 05 Dec 2020

On the Overtime Complete Page, you will see all the details of the overtime from the attached
document to the overtime date and time.



OVERTIME
Choose Status

Select )
File

Browse... | No file selectad.

oad evidence for Overtime done

COMMENTS

OVERTIME JUSTIFICATION REQUEST

this is truly an overtime at home

|Sappypie

MEMO
From: Your Name XYZ
ce: Name ABC
Date: Date XH-XXR-KHKK
— el SAMPLE

- OSPER ANDY AZAFOKPE
- ~

Want io insert a picture from your files or add a shape, text box, or table? You got itl On the
Insert tab of the ribbon, just dick he option you need

en more easy-to-use iools on the Insert tab, such as 1o add a hyperlink orinsert a
ent

document that looks this good has io be difficult 1 format? Think again! To easily apply
tting you see in this document with just a dick, on the Home tab of the ribbon.

OVERTIME DATE AND TIME

Ne of Hours Start Date End Date Start Time End Date

a Sat 05 Dec 2020 Tue 15 Dec 2020 5 pm 9 pm

e C(Click on the Choose Status to either choose completed or cancelled. If you didn’t do the
overtime sent from your supervisor for any reason. You have to select cancelled but if the work
was completed, select completed

e If you have any evidence to be attached, scan the document and download it unto your
computer and click on the browser and find it on your computer to attach to the overtime

e And finally, if you have a comment that you would like to share with your supervisor, enter it at
the comment section it could be from increasing your overtime hours to any grievances. Note
that: every comment that is entered is attached to the overtime and anyone who opens or has
anything to do with the overtime would be able to see it.

e After that click on the submit button to return to your supervisor. By the time, you are done
with the overtime, it will appear on your pay slip.

Send Message Page



ALL OVERTIME REQUEST

Overtime ID Status Justification Request Date Created
1 ‘COMPLETED this is the best work Thu 03 Dec 2020 Create Message

2 APPROVED Faults at best Thu 03 Dec 2020 Create Message

By every completed overtime is a “Send Message”, if for any reason your overtime didn’t appear on your
pay slip, click on the send message by the overtime that didn’t appear and you will be redirected to the
Overtime Issues Report Page.

OVERTIME ISSUES REPORTS
File
Browse... | No file selected.

Please Upload evidence

ENTER DETAILS

e |f you have any evidence to prove the legitimacy of your overtime, scan it unto your computer
and select to attach, by clicking on the browser button, to select the file on your computer.
e Enter all the details on what the problem is and why the overtime should be paid.

NOTE: It will be forwarded to your district manager, who will intend forward it to the regional general
manager of the region then finally he or she will forward it to the head office, for the appropriate action
to be taken, or for you to receive a reply.

Cancelled Overtime

Finally, you will see a cancelled overtime section, where you will find all your overtime that has be
rejected and the reason for its cancellation attached. Note: This list would comprise of cancellation you
have done and ones that was done by a superior

Conclusion

You must periodically login to complete all overtime that have been sent to you on or before the 15 of
the next month.



Supervisors Dashboard

. ANTHONY MENDS JNR
Self Servi
ECGI iGpiication a v
MENY
boards Supervisor's Dashboard
Dashboar

is page displays ¢ jor
My Dashboard
Overtime Groups

Manage Overtime 1 Notifications

OVERTIME REQUESTS
this is an overtime - Sun 06 Dec 2020 [T
Overtime Request Form

this is an overtime - Sun 06 Dec 2020 ([N
Group Overtime Request

Add User to Request
Faults at best - Thu 03 Dec 2020

Q
o
O this is the best work - Thu 03 Dec 2020 ([[EENETIE]
Qo
Add Direct Report 3

This is a test overtimes - Hr has approved overtime - Mon 07 Dec 2020 (IR




e At the top right corner of the page, you will see your name, designation and district

e Beside your name, designation and district, is an icon ~ , click on it and to display your
name, region and district and a logout button.

e C(Click on the logout button to log you out of the software when you are done, to prevent
unauthorized people from gaining access to your account.

e To the left side is your menu, you would see, My Dashboard, Overtime Groups, Manage
Overtime, Overtime Request Form, Group Overtime Request, Add User to Request and Add
Direct Report

My Dashboard

My Dashboard Page is where you will see all the overtime created for you by your supervisor on the
Notifications sections. Displaying the name of the Overtime, the date of its creation and the status of it.
Note: it only shows up to 20 of the last created overtime.

Notifications

this is an overtime - Sun 06 Dec 2020 m
this is an overtime - Sun 06 Dec 2020 m
this is the best work - Thu 03 Dec 2020 m

Faults at best - Thu 03 Dec 2020

o 0 0 0 O

This is a test overtimes - Hr has approved overtime - Mon 07 Dec 2020

Overtime Groups

Overtime groups shows all the groups created, you can edit the overtime and it will update all the
overtime sent to all your direct repot.



Group Overtime Dashboard

board is for all your overtime created

GROUPS
Group ID Title Status Date Created
GxiETHE THE OVERTIME AT HOME Planned Sat 05 Dec 2020 Details
GINSAW NSAWAN OPERATIONS Planned Fri 04 Dec 2020
GRskFOR FOR MAINTENANCE JOBS ABLEKUMA Planned Fri 04 Dec 2020
GLSYTHI THIS OVERTIME Planned Fri 04 Dec 2020

Click on the details button to be able to update the group overtime

OVERTIME DETAILS

Approved or Reject Overtime
Choose Status

Select

COMMENTS

FORWARD TO

Select

e Choose a status which is either approved or cancel
e Enter the comments at the comments sections
e Dropdown the Forward to and select the HR Officer to send it to him / her

Note: Scroll down to view all the details of the overtime from the justification request, to the attached
document to the date and time of the overtime

@



OVERTIME JUSTIFICATION REQUEST - i3

this is truly an overtime at home

45 appypie

MEMO

From: Your Name XYZ
e Name ABC
Date: Date HH-XX-XXXX
Re- Subiect SAMDI E
. ANTHONY MENDS JNR
a 52 FORMATION TECHNOLOG
it with your own.
Want fo insert a picture from your files or add a shape, text box, or table? You got it' On the
Insert tab of the ribbon, just dick the option you need
Find even more easy-to-use tools on the Insert tab, such as o add a hyperlink orinsert a
comment.
Think a document that looks this good has to be difficult to format? Think again! To easily apply
any text formatting you see in this document with just a dick, on the Home tab of the ribbon,
check out Styles.
OVERTIME DATE AND TIME
No of Hours Start Date End Date Start Time End Date
4 Sat 05 Dec 2020 Tue 15 Dec 2020 5pm 9 pm

Manage Overtime



This is the page for managing all overtime within the software, the page display 4 sections; we have
forwarded overtime section, completed overtime section, planned overtime section and my overtime
section

FORWARDED OVERTIME

Employee Name Description Status Created Date

REGINA MINLAH - 156400 This is a test overtimes APPROVED Mon 07 Dec 2020

COMPLETED OVERTIME

Employee Name Description Status Created Date

OSPER ANDY AZAFOKPE - 204942 this is the best work CCOMPLETED Thu 03 Dec 2020

DIRECT REPORT PLANNED OVERTIME

Employee Name Description Status Created Date

OSPER ANDY AZAFOKPE - 204942 this is truly an overtime at home PLANNED Sat 05 Dec 2020

SAMUEL AMANOR QUARSHIE - 202936 this is truly an overtime at home PLANNED Sat 05 Dec 2020
a L] ANTHONY MENDS JNR

MY OVERTIME REQUEST

Employee Name Status Justification Request Date Created

OSPER ANDY AZAFOKPE PLANNED this is an overtime Sun 06 Dec 2020
OSPER ANDY AZAFOKPE PLANNED this is an overtime Sun 06 Dec 2020
OSPER ANDY AZAFOKPE PLANNED this is truly an overtime at home Sat 05 Dec 2020
SAMUEL AMANOR QUARSHIE PLANNED this is truly an overtime at home Sat 05 Dec 2020
OSPER ANDY AZAFOKPE COMPLETED this is the best work Thu 03 Dec 2020
OSPER ANDY AZAFOKPE APPROVED Faults at best Thu 03 Dec 2020

UNCOMPLETED OR PLANNED OVERTIME

Status Overtime Description Date Created

Forwarded Overtime Section

This is the section that displays all overtime that has been forwarded to you, requiring an action to be
performed. These are the fields displayed: Employee name, Description, Status and Created Date.

When you click on the details button



OVERTIME DETAILS

Approved or Reject Overtime

Choose Status

Select

COMMENTS

FORWARD TO

Select

You must select the status of the overtime either approve, review or not certified

Enter comments at the comments section

Forward the overtime to the appropriate staff, which from a supervisor is typically an HR Officer
Click on the submit to forward the overtime to the person, you selected at the forward to

NOTE: Scroll down to display all the details of the overtime, status and the overtime justification,
attachment, date and time. You can edit the overtime by clicking on the edit button. Make the changes
and click on the update button to save the change.

Completed Overtime

This section will display all overtime that have been completed by your direct report. The fields you
would see is the employee name, description of overtime, status and the created date.

Click on the details button

Choose an approved or not certified status.

Enter a comment at the comments section

Select an appropriate user from the forward to and

Click on the submit button to forward the overtime to the person you selected

Planned Overtime

This section will display all overtime that have not be completed by your direct report, so either your
direct report is unaware that you have created for, or the work on the field is yet to be done. The field
you would see is the employee name, description, status or created date.

My Overtime

This section will display all the overtime that has been sent to you by your supervisor and when the
work is completed on the field you are to reply to the overtime by clicking on the details button

Select either completed or cancelled from the Choose Status



e Attach any evidence to the overtime if your supervisor requires it or you want to attach a
document. Scan the document and download it unto your computer. Select the browse to select
it from your computer to attach it to the overtime

e Enter any comment (optional)

e C(Click on the submit button to return it back to your supervisor

Overtime Request Form
This is the form for creating overtime within the system.

Click on the overtime request form

OVERTIME AUTHORIZATION

Staff
Select s
File

Browse... | No file selected

Please Upload evidence for Overtime

OVERTIME JUSTIFICATION REQUEST

Part One
Overtime Authorization

e Select the staff you want to receive the overtime

e C(Click on the browse button to select the file you have scanned and downloaded to your
computer

e Enter the overtime justification.

e After this click on the save overtime to save the first part of the overtime

OVERTIME DATE AND TIME

Start Date End Date
Start Time M s End Time PM s
Number Of Hours Type of Overtime

Select >

Save



Part Two
Overtime Date and Time

e Select the start and end date

e Select the start and end time

e Select the GMT either PM or AM

e Enter the Number of Hours: if the overtime hours is within the start and end time, else leave it
empty

e Select the type of overtime either weekday, weekend or holiday

e C(Click on the save to submit the date and time for the overtime

NOTE: You can add as many overtime date as possible, all you have to do is to select the date and time
and type and save again and again until you have saved all the date and time for the overtime

Group Overtime
Group overtime is the page used to create a group overtime.
Part One

Overtime Authorization

OVERTIME AUTHORIZATION

Overtime Title

File
Browse... | No file selected.

Please Upload evidence for Overtime

OVERTIME JUSTIFICATION REQUEST

e Its starts with an overtime group title, the title is the general idea for the overtime

e If you must attach a document, scan the document and download it to your computer, click on
the browse button and select the file from your computer

e Enter the overtime justification

e C(Click on the submit button to save it.



Part Two

Overtime Date and Time

OVERTIME DATE AND TIME

Start Date End Date

Start Time a EndTime
s

PM PM

“»

Number Of Hours Type of Overtime

@

Select

Save

e Select the start and end date

e Select the start and end time

e Select the GMT either PM or AM

e Enter the Number of Hours if the overtime hours is within the start and end time, else leave it
empty

e Select the type of overtime either weekday, weekend or holiday

e C(Click on the save to submit the date and time for the overtime

Add User to Report

This is the page for adding a direct report to a group. All you have to do is to select the staff and the
group name you created and click on Save Overtime to create a copy of the overtime for the direct
report.

ADD DIRECT REPORT TO GROUP OVERTIME

Staff

Select 2

Overtime

Select s



Add direct report

This is the page for adding direct report to your account. When the HR Officer cerates a new employee
or any employee who have not been assigned to a supervisor but within your district and directorate
you will be able to add to your account, so that you can create overtime for the person as your direct
report.

ADD YOUR DIRECT REPORT

Select s

Staff



Human Resource Activities

HR resource activities are a set of pages that are designed to help with the administration of the
software. Here are the menu links; User logins, All Direct Reports, Approvals, All Employee and Process

Overtime.

User Logins

User logins displays all the log in account within your region or district with an edit button to edit the

login details.

ALL USERS
Username Staff ID
rbentil 148041
sdodeah 152854
eankrah 155390
rminlah 156400
ghommey 163872
aaheto 179876
vekwadade 186481
amends 201717
oazafokpe 204942

Add Direct Report

Region

ACCRA WEST REGION

ACCRA WEST REGION

ACCRA WEST REGION

PROJECTS UNIT

ACCRA WEST REGION

PROJECTS OFFICE

VOLTA

District

DANSOMAN DISTRICT, ACCRA WEST

HOHOE, VOLTA

DANSOMAN DISTRICT, ACCRA WEST

DANSOMAN DISTRICT, ACCRA WEST

PROJECTS OFFICE HQ, PROJECTS UNIT

DANSOMAN DISTRICT, ACCRA WEST

PROJECTS UNIT

HOHOE

Status

Active

Active

Active

Active

Active

Active

Active

Active

Active

Role

User

Supervisor

Supervisor

User

Supervisor

Supervisor

User

Supervisor

User

Date Created

Mon 07 Dec 2020

Mon 07 Dec 2020

Mon 07 Dec 2020

Mon 07 Dec 2020

Sat 05 Dec 2020

Mon 07 Dec 2020

Sat 05 Dec 2020

Sat 05 Dec 2020

Sat 05 Dec 2020

Edit

Edit

Edit

Edit

Edit

Edit

Edit

Edit

Edit

This page displays all users with their staff ID and their supervisors. You have the permission to edit the
supervisor of any direct report within your region or district.

DIRECT REPORTS

Directorate D.R. Name D.R. Staff No. S. Name S. Staff No.
CUSTOMER SERVICES DIRECTORATE RICHMOND GODSLOVE ASHIAMAH 201116 ZITA KYEI-GYAMFI 169650
CUSTOMER SERVICES DIRECTORATE SAMUEL DIASEMPAH 156680 ZITA KYEI-GYAMFI 169650
CUSTOMER SERVICES DIRECTORATE JOSEPH OPPONG-DANQUAH 162345 ZITA KYEI-GYAMFI 169650
CUSTOMER SERVICES DIRECTORATE ABUBAKARI FAROUK 190811 ZITA KYEI-GYAMFI 169650



Approvals

The overtime approving page is very important and its one of the first page an HR Officer, upon creating
his / her account must open. It’s to save all the staffs within the district who will approve an overtime
and their capacity to approve.

OVERTIME APPROVING

Approving Manager

Select s

Approving As

@

Select

COMMENTS

e Forinstance, under the approving manager, the dropdown would display all the staffs, within
the district and their designation, its up to you to select a name

e After select Approving As, by dropping down the list and choosing; that is if the staff would be
approving as a human resource officer, district manager, regional general manager or a
supervisor

e After which if you have a comment to add, you can type it in at the comment section and

e C(Click on the save button

NOTE: Once you save, if you want to add another one, you would select another approving manager and
approving as and click on the save. You can add as many times as the staffs who will be approving
overtime within your district or region.



Add Employee

This page is used to add new employees who are not part of the list of employees within your district.
Now every employee is already in the system its only people who have been recently employed that
must be added. Fill in all the details for adding an employee. And click on the save button.

NEW EMPLOYEE INFORMATION

Employee Name Staff Number
Category Employee Type
Colmmt - LR -
[ ) ANTHONY MENDS JNR
a v
Post Code Job Name
Region District
Select * Select s
Grade Name Address
Phone 1 Phone 2
Contact Name Date of Birth
Identity Email Address
Gender Directorate
Male * Select *

Save

After which the supervisors can add the employee as a direct report, using the add report menu link.



Process Overtime

Process Overtime is a page that displays all overtime that has been forwarded to your account. Instead
of going to the manage overtime and under the forward section and process one by one using the
Process Overtime makes it easier for you to bulk approve overtime

BULK FORWARD

Forward To

ALL FORWARDED OVERTIME

Employee Name Description Status Created Date

REGINA MINLAH - 156400 THIS IS A TEST OVERTIMES Approved Mon 07 Dec 2020

Note: This page is only available to the HR Officers, district managers and regional general managers.

OVERTIME DETAILS

Approve or Review or Reject Overtime VERIFIED FOR APPROVAL

Choose Status

o

Select

COMMENTS

FORWARD BACK TO

Select =

When you click on the Process Overtime.

o Select the forward to, the forward to will display the list of people you can forward to and the
overtime displaying under the All Forwarded Overtime.

e When you click on the details button you will see, choose status, you can choose either Not
Certified or Send it for review

e If you have any comments to add, you type it in the comments section

e And you can forward it back to the staff within the forward to dropdown and

e C(Click on the submit button

Note: You can scroll down to see all the details of the overtime and you can edit by clicking the edit
button, also you only fill these if you want to reject the overtime otherwise click on the verified for
approval to return back to the list of overtime to be bulk transferred.



You can do this for every overtime until you are satisfied with every overtime display then click on the
forward button to forward all the overtime within the list below to the staff you select at the forward to

Note: The All Forwarded Overtime section will display all overtime that has been sent onto your account

for approving. By clicking on the details button, you will see all the details of the overtime and you can
reject the overtime or edit the overtime.

Once you reject an overtime it wouldn’t be part of the list you will bulk approve, it will be returned to
the person who sent it to your account.

overTime susTiFICATION REQUEST - (I

This is a test overtimes

15 appypie

MEMO

ABC
I HOR-HHHOK

SAMPLE

adocument Iatiooks Tus 9O0d NAS 1 be AIMCUIt 1o Tormat? Think agan! To sasily apply
ing you see is document with just a click, on the Home tab of the ribbon

t formatting
check out Stes.

No of Hours Start Date

erd Date seart Time End Doaca
- Sun 20 Dec 2020 2 pm 5 prm Ean
STAFE REPLY
Approved
G appypie
E— Vo Mane vz
- rame ABc
3 ANTHONY MENDS JNR i
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e insert tab, such as o add & hyperlink or insert a

Think a document that looks #is good has o be difficult 1o ormat? Think To easily apply
any text formatiing you oo i BiS Gocument with ISt s oK, on e Hame b of the ribben
check out Styte:




